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Preface 

Preface 

This book is your guide to the Artline 2.0 utilities. The utility pro­
grams described in this book are: 

o Font Filter Conversion programs; 

o Digital Research Output printing software; 

o MAGICorp@ slide and print service. 

There are also appendices that list the Artline interna­
tional character set, the methods for changing the . CNF 
files that you use for printing, and the font ID numbers 
for various typefaces. 

Use this guide as a companion to the following Artline 
publications: 

o Artline Installation / Startup Tutorial. A guide describ­
ing how to install Artline, utilities, and associated soft­
ware; and a task-oriented tutorial demonstrating the 
creation and use of pictures. 

o Artline User Reference Guide. A reference guide to 
menu commands, dialog options, and tools. 

o Artline Clip Art Gallery. A pictorial reference guide to 
clip art libraries. 
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Font Fil-ters 

THIS chapter describes Artline's font filters, special programs that 
convert font files to the Artline AF4 format. 

Filters are available for font files in these formats: 

o Bitstream® Fontware™ .PFA 
o Adobe® Type 1 .PFB 
o Fontographer® .PFA 

There are three font filters, each with a name intended to 
help you remember its function. 

o The Bitstream Fontware conversion file is called 
BLDAF4.EXE ("From Bitstream .PFAs to build AF4"). 

o The Adobe Type 1 conversion file is called 
TP12AF4.EXE ("Type 1 to AF4"). 

o The Fontographer conversion file is called 
FGF2AF4.EXE ("FontoGrapher to AF4"). 

Running Font Filters 

Font Filters 

You can run font filters from the command line or by 
using the To App command in Artline. You should nor­
mally run the font filters from the command line if you 
have long path names, or if you want to use the various 
switch settings in converting fonts. 
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Running Font Filters 

1-2 

To Use the To App Command: 

[I] Choose the ToApp command from the File menu. 

~ In the Run Application dialog, click on the Run but­
ton to display the I tern Selector. Then follow these 
steps: 

- Open the ARTLINE directory, and then open the 
CONVERT sub-directory. 

- Double-click on the appropriate application file, 
which in this case is BLDAF4.EXE, to place it in 
the Run box, as shown below. 

Run App_lication 

Run I C:\ARTLINE\CONUERT\BLDAF4. EXE I 

Para(l1eters Application T!Jpe -
o Current File o GEM 
o Current l(I1age @ DOS 
@ Request ... 
o None D Full Me(l1or!J 

Options 
~ Auto-Save Current Picture I OK I 
D Return To Artline 

I Cancel I 

[]] Select the following options in the Run Application di­
alog: 

- Request for Parameters. 

- DOS for Application Type; 

- Auto-Save Current Picture if you want to save a 
picture currently displayed in Artline before the 
font conversion begins; 

- Return to Artline if you want to return to Artline 
after the fonts are converted. 

[]J Click on OK to exit the dialog and then display the 
Command Line dialog. 
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Font Filters 

Running Font Filters 

[]] In the Command Line dialog, type the path for the 
font conversion in this order (note that the space for 
the path is limited): 

- In the left, or source, part of the Command Line 
field, type the name of the directory or sub-direc­
tory in which the PostScript fonts are stored. In 
the example shown below, the partial path 
\OUTLINES indicates that this directory is on the 
default drive, C. 

- At the end of the source path, type the filename of 
the PostScript font (DFGQ in the example shown 
below), without its extension. Make sure that you 
insert a space at the end of the source path. 

- In the right, or destination, part of the Command 
Line field, type the path to where the converted 
font will be stored (usually this will be the FONTS 
sub-directory of ARTLINE). 

- At the end of the destination path, type the 
filename you want to assign to the converted font. 

COMMand Line 

Enter the cOrrJMand line for BLDAF4.EXE 

I\OUTLINES\DFGQ \ARTLINE\FONTS\WINDSORL---I 

OK I I Cancel I 

[]] Click on OK to convert the font. You are prompted 
throughout the conversion process. 
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Bitstream Fontware Conversion 

Bitstreom Fontwore Conversion 

When generating 
Fontware files, set up 
the control panel for 
PostScript printer fonts 
only. You do not need 
to create screen fonts. 

1-4 

Bitstream Fontware PostScript printer font files have the 
extension .PFA. They can be created by versions 1.2 and 
2.0 of the program. The version of Fontware that is used 
with GEM Artline generates .AFF files that cannot be con­
verted to .AF4 files. 

In addition to the font's .PFA file, you need two other files 
that should have been created at the same time. Both 
files have the same name as the .PFAfile; they differ only 
in their extension. 

o A font information file (.PFI) is required. BLDAF4 
cannot create the .AF4 file without it. 

o An Adobe font metric file (.AFM) must be present if 
you want to be able to kern characters. Kerning is dis­
cussed in the Artline User Reference Guide. 

The command line for creating an Artline font file from a 
Bitstream Fontware file is: 

BLDAF4 PFA filename[.PFA] [AF4 filename[.AF411 

Square brackets indicate optional components of the 
command line: 

o AF4 filename-if you do not provide an AF4 filename, 
the .AF4 file will be created with the same name as the 
.PFAfile. 

o File extension-the BLDAF4 program automatically 
looks for files with the .PFA extension and converts 
them to files with the .AF4 extension. 

The following command line converts CUPQ.PFA-the 
Bitsteam Fontware file for ITC Galliard®-to a file called 
GALLIARD.AF4: 

BLDAF4 CUPQ GALLIARD 
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Adobe Type 1 Conversion 

Adobe Type 1 Conversion 

Font Filters 

Adobe Type 1 files-also called binary PostScript-have 
the extension .PFB. In the Adobe Type Library sets, the 
.PFB file is usually in the PSFONTS directory on the first 
disk of the set. The .AFM file, which contains the infor­
mation that is required for kerning, is usually in the root 
directory of the third disk. 

The command line syntax for converting Type 1 files is as 
follows: 

TP12AF4 PFB filename[.PFB] [AF4 filename[.AF4]] 

[/I=x] [/W=x] [/ A=OFF] 

Square brackets indicate optional components of the com­
mand line: 

o AF4 filename-if you do not provide an AF4 filename, 
the .AF4 file will be created with the same name as the 
.PFB file. 

o File extension-the TP12AF4 program automatically 
looks for files with the .PFB extension and converts 
them to files with the .AF4 extension. 

o The 11= switch giv~s the font identifier number (font 
ID). This number makes it possible for you to use resi­
dent fonts when present in your printer or typesetter. 
Appendix C contains a complete list of font IDs. 

If you do not provide a font ID, TP12AF4 automatically 
supplies the default ID of255. Taking the default can 
potentially lead to duplicate font IDs. See page 1-9. 
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Adobe Type 7 Conversion 
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o The IW = switch gives the weight of the font. The 
switch accepts these values: 

- o = Roman 
- 1 = Bold 
- 4 = Italic 
- 5 = Bold Italic 

If you do not provide a weight value, the default value 
o (Roman) is supplied automatically. 

o The IA=OFF switch turns off all warnings and alerts. 

The following command line converts BDB __ .PFB (the 
Adobe Type 1 file for the Bodoni Bold typeface) to a file 
called BDNIBOLD.AF4: 

TP12AF4 BDB__ BDNIBOLD 11=36 1W=1 
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Fontographer Conversion 

Fontographer Conversion 

Font Filters 

Fontographer files have the extension .PFA. The kerning 
files have the extension .AFM. 

The command line syntax for converting Fontographer 
files is as follows: 

FGF2AF4 PFAfilename[.PFA] [AF4fi1ename[.AF4]] 

[/I=x] [/W=x] [/ A=OFF] 

Square brackets indicate optional components of the com­
mand line: 

o AF4 filename-if you do not provide an AF4 filename, 
the .AF4 file will be created with the same name as the 
.PFAfile. 

o File extension-the FGF2AF4 program automatically 
looks for files with the .PFA extension and converts 
them to files with the AF4 extension. 

o The II= switch gives the font identifier number (font 
ID). This number makes it possible for you to use resi­
dent fonts when present in your printer or typesetter. 
Appendix C contains a complete list of font IDs. 

If you do not provide a font ID, FGF2AF4 automati­
cally supplies the default ID of 255. Taking the default 
can potentially lead to duplicate font IDs. See page 1-9. 
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Fontogropher Conversion 
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o The IW = switch gives the weight of the font. The 
switch accepts these values: 

- O=Roman 
- 1 = Bold 
- 4 = Italic 
- 5 = Bold Italic 

If you do not provide a weight value, the default value 
o (Roman) is supplied automatically. 

o The IA=OFF switch turns off all warnings and alerts. 

The following command line converts BDB0024.PFA (a 
Fontographer-format file for the Bodoni Bold typeface) to 
a file called BDNIBOLD.AF4: 

FGF2AF4 8080024 80NIBOLO 11=36 IW=1 
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Duplicate Font IDs 

Duplicate Font IDs 

Font Filters 

If you do not provide a font ID when converting Adobe 
Type 1 or FontoGrapher font files, the conversion pro­
gram automatically supplies the font ID 255. The next 
time you convert a font, you must provide a unique font 
ID, or you will encounter problems caused by duplicate 
font IDs. 

Fonts with duplicate IDs cannot be added to the font list 
in Font Manager. (See Chapter 9 of the Artline User Ref­
erence Guide.). Mter the first font is added to the font 
list, attempts to add others with the same ID result in the 
display of the alert shown below: 

, .. I.. The typeface you want to install [][] 
.., is already installed as 

Bodoni. 
Before installing this typeface 
you should reMove the existing one. 

There are two ways you can avoid this situation: 

o Use the correct ID for the font you are creating. Font 
IDs are listed in the table in Appendix C. 

o If you cannot provide the correct font ID, specify a font 
ID for each new font that is one less than the ID given 
to the previous font-255, 254, 253, and so on. 
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Output 

T he Output application prints and displays files created with Artl­
ine (and with other Digital Research graphics applications). 

With Output, you can: 

o print one or several files; 

o display files on your screen; 

o make and save lists of files for later printing or display; 

o redirect your output to a file for transmission over a 
network or to a remote device, such as a Linotronic ™ 

phototypesetter. 

Starting Output 

Output 

To Start Output: 

Display the File menu and choose the To Output com­
mand. The Output screen appears. The name of the file 
that was open in Artline automatically appears in the 
FILES TO PRINT list on the Output screen. 
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Output Screen 

Output Screen 

2-2 

BARN.GEM 

BOLT. GEM 

CAPITOL.GEM 

CHEESE.GEM 

COURTHSE.GEM 

CROPS.GEM 

DONTSIGN.GEM 

F IREXTIN. GEM 

GAVEL.GEM 

GRAPES.GEM 

HAMMER. GEM 

LIGHTBLB.GEM 

The components of the Output screen are: 

o The START button begins the printing or displaying of 
a file. 

o The menu bar lists the names of the Output menus. 

o The title bar contains the full path specification of the 
current output list file, if one is open. 

o The FILES TO PRINT list shows the names of files to 
print or display. 

o The Remove name button removes selected files from 
the FILES TO PRINT list. 

o The File Selector window lists the disk drives and di­
rectories from which you select files to add to the 
FILES TO PRINT list. 

o The Copies button shows the number of copies to print. 
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Printing 

Printing 

o The DEVICES window contains icons representing the 
output devices you installed during Setup. Initially, 
the Output window appears in the center of the screen. 
You can move the Output window by dragging its title 
bar. 

If you are in Artline, open the file you want to print. 
Then choose To Output from the File menu. When the 
Output screen appears, the filename appears in the 
FILES TO PRINT list. 

To print the files: 

[JJ Click on the icon of the device (in the DEVICES win­
dow) to which you want to send the file. 

[]] Click on the START button. (The keyboard shortcut 
is Alt-S.) 

The time required to print files depends on the size of 
each file. 

Other printing options: 

Output 

o To add files to the FILES TO PRINT list, click on the 
filename(s) you want in the File Selector. 

o To remove a.filename from the FILES TO PRINT list, 
select the name, then click on the Remove name but­
ton. (The keyboard shortcut is Alt-R.) To remove more 
than one file, select the filenames with the Shift-click 
technique. 

o To change the number of copies, click on the Copies but­
ton, use the Backspace key to clear the field, then 
enter the number of copies you want (up to 99). (Out­
put resets the number of copies to 1 two minutes after 
the last document is processed.) 
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To Exit Output 

To Exit Output 

File Selector 

(:\ ... RT\PEOPLE 
H I Dictures I all 

CLERK. GEM 

COMP _OPR. GEM 

DESK. GEM 

DRAFTER. GEM 

FARMER. GEM 

F IL ING. GEM 

MA ILCARY. GEM 

MAN. GEM 

MAN1. GEM 

PHOTOGI'.. GEM 

READ ING. GEM 

STUDENT. GEM 

HOMAN. GEM 

HOMAN1. GEM 

2-4 

The To Artline command from the File menu returns you 
to Artline. To exit Output and return to the operating sys­
tem prompt, choose the Quit command. 

Use the File Selector to add filenames to the FILES TO 
PRINT list. 

The current disk drive and directory are identified in the 
directory line of the File Selector. The example shown to 
the left displays the files in a sub-directory of drive C. On 
the directory line, long directory names are abbreviated 
so that only the last two letters of the name appear. 

To find files in a different directory or drive: 

o To open the next higher level in the directory path, 
click on the close box in the upper left corner. Thus, if 
the directory line reads c: \CLIPART\PEOPLE and you 
click on the close box, the directory line changes to 
c: \CLIPART. Directory names are preceded by an as­
terisk to distinguish them from filenames. 

o To open a subdirectory, click on the subdirectory name. 

o To change disk drives, click on the close box until the 
disk drive identifiers are listed; then click on the drive 
you want. 

The directories, subdirectories, and filenames in the direc­
tory list are displayed in the following order: 

o Directories and subdirectories display first and are 
marked by a backslash (\). 

o Filenames are listed second, alphabetized by filename 
extension. Thus, .GEM files are alphabetized together 
and listed before .IMG files. 
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Output 

File Selector 

Click on each filename in the File Selector list that you 
want to print or display. To place all the files in a direc­
tory in the FILES TO PRINT list, click on the .all box in 
the upper right corner of the File Selector window. 

If the File Selector list contains more directories or 
filenames than can be displayed in the window, you can 
move the slider up or down to scroll the list: 

o To scroll toward the top of the list, click on the up­
arrow (at the top of the slider)-the directory list 
moves one filename for each click. Hold the mouse but­
ton down to move continuously toward the top of the di­
rectory list. To scroll toward the bottom of the list, 
click on the down-arrow (at the bottom of the slider)­
the directory list moves one filename for each click. 

o You can scroll the length of one window by clicking in 
the scroll box either below or above the slider. 

o To scroll by larger segments of the list, drag the slider 
in the direction you want to move. 

File Types 

File types are categorized by file extension. To change the 
type of files listed in the directory window, click on the file 
box. For example, if the file type indicated is images, only 
files in the specified directory having the file extension 
.IMG will display in the directory list. 

Duplicating Filenames 

To use a filename more than once in the FILES TO 
PRINT list, click on the filename in the File Selector as 
many times as you want it to print. 

Changing Filename Order 

To change the position of a filename in the FILES TO 
PRINT list, click on the filename to select it, and then 
drag the filename to the new position in the list. 
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Creating Output Lists 

Creating Output Lists 

2-6 

To create an ou tpu t file list: 
[]] Add filenames to the list in the FILES TO PRINT 

window. 

[]] Choose Save as from the File menu to display the 
I tern Selector. 

Director!J: 
(:\CLIPART\*. LIS. ___________ _ 

HI *. LIS 

GROUP1 • LIS 
.. 

GROUP2 .LIS r-' 
Selection: 1--1--

-· -· --
- OK 
- ..... 
· - .... I Cancel I 

[]] Enter a name for your list (up to eight characters) on 
the Selection line. Output automatically supplies the 
file extension .LIS when you exit the Item Selector. 

[]] Click on OK or press the Enter key to save your list. 

Use Save to preserve subsequent changes to the list, and 
use Save As to save changes under a different name. 

NOTE: Whenever you use the list, the files in it must be present in 
the same directory and have the same filenames as when 
the list was created. If you rename, move, or delete one of 
these files, you must update the output list. 
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Displaying Files 

Opening Output Lists 

To open an output list: 

[!] Choose the Open command from the File menu. 

[]] In the Item Selector, find and select the output list 
filename. 

When you open an output list, Output displays the 
filenames in the FILES TO PRINT list. The title bar 
shows the location and name of the list. 

Displaying Files 

Menus 

Output 

To send one or more files to your display: 

[!] Select the files with the File Selector. 

[]] When all the files are listed in the FILES TQ PRINT 
window, click on the display icon in the DEVICES 
window. 

[]J Click on the START button to begin displaying the se­
lected files. 

[1] Mter the first file displays, click the mouse button to 
advance to the next one. Press the Esc key to cancel 
the display. 

You can display menus and choose commands with the 
mouse, or you can use the keyboard. 

To "un-display" a menu chosen with the mouse, click out­
side the menu. 
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File Menu 

File Menu 
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Use the File menu to open and save .LIS files and to quit 
Output. 

New 
Dpen ... 

~~~~@@@@@@~@@@@@*@@@@~ 

Save 
Sa.v.e as ••• 

@@@@@@@@@@~@@@*@*@@@@~ 

To Artline 
Duit 

New Command 

The New command clears all filenames from the FILES 
TO PRINT list and from the title bar. 

Open Command 

The Open command displays the Item Selector, in which 
you select files to add to the FILES TO PRINT list. If you 
select a file while the the FILES TO PRINT list contains 
one or more filenames, the file is appended to the list. 

Save Command 

The Save command saves the current output list in a file 
under the name appearing in the title bar. 

Save As Command 

The Save as command displays the Item Selector. Use 
this command to name and save an output list for the 
first time, or to save an existing output list under a new 
name. 
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Output 

File Menu 

To Artline command 

The To Artline command returns you to Artline. 

Quit Command 

The Quit command exits Output and returns you to the 
operating system prompt. 

Abandon/Save Alert 

When you choose the New, Open, or Quit command 
after making changes to an output list file, Output dis­
plays the Abandon alert. (It displays only if you have se­
lected the .LIS Changes box by using the Global 
command from the Options menu.) 

~ Abandon/Save edited .LIS file? I Abandon 

Save 

Cancel 

With this alert, you have these options: 

Abandon 

Output abandons any changes you have made to the out­
put list file and carries out the selected command. 

Save 

The output list file is saved under its current name, or a 
name you select, before your original command executes. 

Cancel 

The command is canceled and the output list remains as 
it was. 
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Options Menu 

Options Menu 

2-10 

Use the commands on the Options menu to set device 
printing options. 

Global ... 
fage Scale .. . 
File Label .. . 
Hetwork settings 

Save references 

Global Command 

The Global command displays the Global Options dialog. 

Print pages numbered 001 through 999 

Prints a range of pages from a document. To set a page 
range, click on the number you want to change, use the 
Backspace key to clear the field, then type the new num­
ber. (The numbers refer to the sequential number of con­
secutive pages, not to any page numbering scheme used 
in the document.) 
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Output 

Options Menu 

Confirm .LlS changes 

If you click on this box, Output displays the Abandon 
alert whenever you make changes and then choose New, 
Open, or Quit. If you don't click in the box, the alert will 
not display. 

Page Scale Command 

The Page Scale command displays the Printer Page 
Scale Options dialog. 

Crop to page 

Prints the picture in its actual size and centers it on the 
page. Any part of the picture that does not fit on the page 
is cropped. 

Mosaic 

Prints the picture at its actual size, over as many pages 
as necessary. You can use the Mosaic option to print seg­
ments of the picture on several pages and then paste the 
segments together to form the picture at its original size. 

Scale to page 

Enlarges or reduces the picture to fit on one full page. 
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Options Menu 

4 to a page 

Prints pictures from four files on the same page; each pic­
ture is scaled to occupy one-quarter of the page. 

File Label Command 

2-12 

The File Label command displays the Printer Prefer­
ences: File Label dialog. 

~-- File label position -----, 
o Left @ Center 0 Right 

[] Include path 

[] Include date & tine 

Print File Label 

Prints a filename at the bottom of each page in the posi­
tion you choose-Left, Center, or Right. 

Include path 

Includes the complete path name in the file label. 

Include date & time 

Includes the operating system's date and time stamp in 
the file label. 
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Output 

Options Menu 

Network Settings Command 

The Network settings command is not applicable to Artl­
ine because it can be only be used by network users. 

Save Preferences Command 

The Save preferences command saves: 

o All Options menu dialog settings; 
o The currently selected device; 
o All device preferences set in the Preferences menu dia-

logs, not just those set for the currently selected device. 

The next time you start Output, the preferences you 
saved last will be in effect. 

To restore Output to the default preferences (those exist­
ing when you first installed Artline), exit to the command 
line and then enter these commands: 

CD \ARTLlNE.J 

DEL OUTPUT.lNF .J 

The first command accesses the ARTLINE directory, and 
the second command deletes the file in which your Out­
put preferences are stored. A new .INF file is created 
each time you use Output. 
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Preferences Menu (Screens) 
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The commands listed in the Preferences menu depend on 
the selected output device. If the device is a screen, the 
Preferences menu lists only the Screen command. 

Screen Command 

The Screen command displays the Screen Preferences di­
alog. 

[] Repeat list until ~ key? 

[ Pause between pictures until: ~ 
o Key @ Tine 

Note that the icon for the currently selected screen ap­
pears in the upper left corner of the dialog. 

Repeat list until Esc key? 

When this option is turned on, the files in the Output list 
are displayed repeatedly until you press the Esc key. 

Pause between pictures until: 

Key 

You must press one of the keys listed in the following 
table to display the next or previous file in the list. You 
can also click the mouse button to display the next file. 
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Preferences IVlenu (;)creens) 

This table lists the Output keyboard shortcuts to use 
when you are displaying files: 

To display To display 
the next file: the previous file: 

Tab PgUp 

PgDn Shift-Tab 

Return Backspace 

Time 

This option sets Output to cycle automatically through 
the output list, displaying each document for the time 
specified in the "Time to pause" field described next. 

Time to pause: 

To change the setting, use Shift-Del or the Backspace 
key to clear the field, and then type the number of sec­
onds to pause between files or pages (from 0 to 99 sec­
onds). Once you start output to the screen, you can stop 
the display by pressing the Esc key. 
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Preferences Menu (Printers and Plotters) 
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The commands listed in the Preferences menu depend on 
the selected output device. If the device is a printer or 
plotter, the Preferences menu lists four commands spe­
cific to printers and plotters. 

freferences 
Paper ~ize .. . 
Paper .tray .. . 
Port selection ... 

Note that the icon for the selected printer or plotter ap­
pears in the upper left corner of each dialog displayed by 
these commands. 

Paper Size Command 

The Paper size command displays the Printer Prefer­
ences: Paper Size dialog. 

Letter ( B.SOx11.00) 

Half ( B.50x 5.50) 

Broad (1B.DOx24.00) 

A4 ( B.27x11.69) 

(ustO(i1 ( B. 50 x11. 00) 
~ I<{ ]:::»1 ~ II 4 FH H<d ~ 

WIDTH HE IOHT 

legal ( B.SOx14.DD) 

ledger (11.00x17.0D) 

Wide (14.00x11.00) 

B5 ( 7.17x 9.B4) 
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Preferences Menu (Printers and Plotters) 

Click on the button that indicates the size you want. To 
view the sizes in metric, click on the Centimeters button. 

To set a size that is not listed, click on the Custom button 
and then set the page width and height with the scroll 
bars under the button. The minimum setting is 2 inches 
(5 centimeters); the maximum is 25 inches (63.5 centime­
ters). 

You can change the settings by moving the slider, by click­
ing in the scroll bar, or by clicking the left- or right-arrow. 
Clicking in a bar changes the value by 0.5 inch or 0.5 cen­
timeter. Clicking on the arrows changes the value by .01 
inch or .01 centimeter. 

Paper Tray Command 

The Paper tray command displays the Printer Prefer­
ences: Paper Tray dialog. 

~ Default - Main Tray or Continuous Forn 

o Manual Feed 

o Optional Tray []t[J 

Default - Main Tray or Continuous Form 

This option directs single-sheet output (typically on a 
laser printer) to the paper tray designated as the default. 
This is also the option to choose for continuous form or 
roll paper on dot-matrix and similar printers. 
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Manual Feed 

This option sets your printer or plotter for a manual feed 
option, or for a pause between pages. This is useful with 
single-sheet printers and most plotters. 

Optional Tray 

This option allows you to print from a tray other than the 
printer's main tray. To specify a tray number, use Shift­
Del or the Backspace key to clear the field and then 
type the tray number. 

Port Selection Command 

The Port selection command displays the Printer Prefer­
ences: Port Selection dialog. 

Send output to: ------, 
@ File 
() Serial: (OM1 
() Parallel: LPT2 

Directory: (: \PT~'}-__________ _ 

File: PRINTSPL.&&& 

Send output to: 

These options redirect your output to a file or to a device 
other than the one specified in your installation. 
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Preferences Menu (Printers and PlotterS) 

File 

The output is redirected to a file. When you select File, 
the two dimmed fields at the bottom of the dialog become 
available: 

o Directory: 

Enter the full path specification of the file in this field. 
By specifying a disk drive identifier other than the cur­
rent drive, you can create the file on another disk. 

o File: 

Enter the name of the file in this field. 

Serial or Parallel 

To redirect your output to a device connected to a port 
other than the one specified in your installation, click on 
the Serial or Parallel button and then enter the port num­
ber for the target device. 

For example, to print to a parallel device connected to 
LPT5, click on the Parallel button and then type 5 in the 
LPT field. 
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Preferences Menu (Cameras) 

Film 
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If you installed a camera device, click on the icon for this 
device in the DEVICES window. In the Preferences 
menu, the Film and Color commands become available. 

When you choose the Film command, Output displays 
the Camera Preferences: Film dialog. In this dialog you 
specify the type of film you will use. 

Filrrl Type Lightness 

@ Polaroid 669/691 BJ 
0 Polaroid PolachroMe [:=£] 
0 PolachroMe HC 

0 Polaroid 339 Autofil BJ 
0 Reserved for future use D 
0 Reserved for future use @] 
0 Reserved for future use 

0 Reserved for future use rm 
0 Reserved for future use ~ 

Film Type 

Click on the button for the film type you will use. The 
film types listed are device-dependent. 
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Color 

Preferences Menu (Cameras) 

Lightness 

This setting lets you vary the exposure of your pictures. 
The 0 setting is average for most films. Experiment with 
your equipment to determine which settings are best. 

When you choose the Color command, the Camera Prefer­
ences: Color dialog appears. 

Color inde~: rn_Wrnrnmmrn 
ITJmOO[ID[J[]OI]IJ!]lJI] 

Current Color Setting 

Basic color: I White II Black IM$lMI Green II Blue II Cyan 

I Yellow I IMagental I Brown II Orange II Grey II Purple I 

Intensit!J: I Light ImDJllrnmrnrnrnl Dark 

In this dialog you can change the colors your camera pro­
duces. But other factors can affect your results, such as 
the film type, the speed rating, the film age, the ambient 
temperature, and the humidity. 

Color index 

Use this option to identify the color associated with the 
color code used in Artline. For example, yellow is the de­
fault color associated with 6. 
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Red 

100% 

0% 

0% 

100% 
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Basic Color 

Use this option to change the color associated with a se­
lected color index number. For example, you could 
change color 6 from yellow to blue. 

Intensity 

Use this option to make the color darker or lighter. 
Higher numbers decrease the color intensity, while lower 
numbers increase it. 

RGB Percentages 

In the percentage counters at the lower left of the dialog 
you can change the amount of red, green, or blue in a se­
lected color. Use the Backspace key to delete the cur­
rent setting and then enter a new setting. 

You create new colors by specifying percentages of red, 
green, and blue. However, the existing Basic color and in­
tensity settings may become irrelevant because they are 
based on standard values. Also, because cameras and 
films vary, you may have to experiment to get the exact 
colors you want. The following table shows the results of 
various RGB combinations: 

Green Blue Result 

0% 0% Pure Red 

0% 100% Pure Blue 

0% 0% Black 

100% 100% White 
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Output Menu 

Output 

Output Info Command 

The Output Info command displays a dialog that identi­
fies the version number of the Output you are using. 
Refer to this number when you call for technical support. 

Release 4.B 

(op~right (cl 19B5-199B 
Digital Research Inc. 
All rights reserved. 

Authors ---------, 
Ann Schrader 

Susan B. (ha~plin 
Nick Webb 

2-23 





MAGICorp 

T his chapter describes how to use the MAGICorp Service with 
Artline. 

MAGICorp Service 

MAGICorp 

You use the Service to send your Artline pictures for con­
version to one of the following media: 

o 35mm slides 
o color photo prints 
o color laser prints 
o color transparencies 

The MAG ICorp Slide Service driver is a special device 
that you can install when you install Artline. 

To use the MAGICorp Service you must have a MAGIC­
orp site code (described below). You may send your Artl­
ine files by modem or by diskette. To send by modem, you 
must have a Hayes™-compatible modem installed on your 
system. When you send by diskette, the diskette is not re­
turned. 

Site Code 

If you are using MAGI Corp for the first time, you must ob­
tain a 5-digit site code from MAGICorp to open a billing 
account. 
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To obtain a MAGICorp site code: 

o Call MAGICorp at one of the following numbers: 

1-800-367-6244 (inside the continental U.S.) 

1-914-592-1244 (outside the continental U.S.) 

o Provide MAGICorp with the following information: 

- Artline program name and version number; 

- your mailing address (this cannot be a post office 
box). 

- your billing address if it is different from your 
mailing address. 

Your site code must be in the Customer Information dia­
log each time you send files to MAGICorp-you cannot 
send files without a valid site code. The Customer Infor­
mation dialog is described in this chapter. 

Using The MAGICorp Service 

To send your Artline files to MAGICorp for conversion to 
slides, prints, or transparencies, perform these steps: 

[]J Prepare your Artline pictures: Although they do not 
have to be in a specific format (MAGICorp will auto­
matically size pictures to the correct format), it is 
helpful if your files are sized for 35mm slides, even if 
you are ordering transparencies or prints. 

[1J Choose the To Output command from the Artline 
File menu. The Output screen appears. 
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j( PT 

j( SPIN 

j( TYPESET 

j( VENTURA 

MAGICorp 

MAG/Corp Service 

choose _--+-++ 
MAGICorp 

~ Click on the MAGICorp device in the DEVICES win­
dow. Then choose the Preferences menu to display 
the MAGICorp commands. 

freferences 
Custo~er info .. . 
Media selection .. . 
lilobal background .. . 
Work order .. . 
frans~ission .. . 
Showsto er shadows ... 

[]] Choose each command in sequence. In the 
MAG ICorp dialog corresponding to each command, 
fill in the information. The dialogs are described in 
this chapter. 
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To transmit to MAGICorp: 
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NEWL.OCiOl.CiEM 

OV lEW-I. CiEM 

OVIEW-iLCiEM 

[] Use the File Selector to choose the file or files you 
want to transmit. These appear in the FILES TO 
PRINT list. 

ples: 

~B1 

[]] Click on the MAGICorp device in the DEVICES win­
dow. 

[]] Click on the START button to transmit. 
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Customer Information Dialog 

MAGICorp 

To display the Customer Information dialog, choose the 
Customer Info command from the Preferences menu. 

Complete all fields in the dialog. 

L 
NaMe: 

DepartMent: _________ _ 
(oMpan!J: 
Street: 

(it!J: 
State/Province: ______ _ 

Postal code: 
(ountr!J: ______ _ 

Phone nUMber: 

MAGICorp site code 

Type your five-digit site code. 

Nome 

Type your name (you have 30 character spaces). 

Deportment 

Type your department name (you have 30 character 
spaces). If you have room, add your department mail stop. 

Company 

Type the name of your company (you have 30 character 
spaces) .. 
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Street City, State/Province, Postal Code, Country 

Type your shipping address-this cannot be a post office 
box (you have 30 character spaces). 

Phone Number 

Type your complete phone number, including the area 
code. 

To exit the Customer Information Dialog: 

When you have completely filled in all fields in the dialog, 
click on OK to accept the settings and exit the dialog, or 
click on Cancel to discard the changes. 

Media Selection Dialog 

To display the Media Selection dialog, choose the Media 
Selection command from the Preferences menu. 

Nunber of Sets: L­
@ Standard 
o Wess 
o Unnounted 

~ Color laser Prints 

I Nunber of Sets: 

~ Color Photo Prints 

Nunber of Sets: 
@ Glossy 
o Matte 

~ Color Transparencies 

Nunber of Sets: 
D Mounted 

Click on the option buttons to set one or more of the fol­
lowing options. 
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Number of Sets Fields 

Note that each option has a Number of Sets field. Use 
this field to enter the number of sets of each option type 
you want to receive. A set is composed of the files you 
have selected to print in the Output FILES TO PRINT 
list. 

35mm Slides 

Choose this option to have 35mm slides developed from 
your files. Enter the number of slide sets you want to 
have developed in the Number of Sets field, then choose 
one of the following options. 

Standard 

The slides have a plastic, pin-registered slide mount. 
They fit 80- and 140-frame Carousels. 

Wess 

The slides have a plastic, pin-registered slide mount, plus 
heat-resistant glass plates covering the film to protect 
against warping, fingerprints, and dust. They fit 80-
frame Carousels only. 

Unmounted 

This option provides unmounted 35mm slide film in a sin­
gle strip, with eight frames per foot. 

Color Photo Prints 

Choose this option to receive color photo prints of your pic­
tures. The prints are 81J2" x 113/4". Enter the number of 
color print sets you want to have made in the Number of 
Sets field, then choose one of the following options. 

Glossy 

This option provides a shiny finish on heavy photographic 
stock. 
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Matte 

This option provides a flat, non-reflecting finish on heavy 
photographic stock. Matte finish does not show finger­
prints. 

Color Laser Prints 

Choose this option to receive color laser prints. The 
prints are 8.5" x II" in full color on standard bond paper. 
Enter the number of color laser print sets you want to 
have made in the Number of Sets field. 

Color Transparencies 

Choose this option to receive color transparencies. The 
transparencies are 8.5" x 10". Enter the number of trans­
parency sets you want in the Number of Sets field, then 
choose the following option if you want to have your trans­
parencies mounted. 

Mounted 

Choose this option if you want to have your transparen­
cies mounted in cardboard frames. Mounted transparen­
cies are sturdier and easier to handle without getting 
fingerprints on the film. 

To exit the Media Selection dialog: 

Click on OK to accept the settings and exit the dialog, or 
click on Cancel to discard the changes. 
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Global Background Dialog 

To display the Global Background dialog, choose the 
Global Background command from the Preferences 
menu. 

@ Original 
o Solid 

Red: L 
Green: o Gradated 

Gradation style ": Blue: 

MAGICorp 

~ Showstopperm Background 

I NUMber: D Tint I 

You use the dialog to define a background for all the pic­
tures you send. 

The MAGICorp global background overrides the back­
grounds in all the files in Artline, unless you choose the 
Original option on this dialog. 

You can set the following options on the dialog. 

Original 

Choose this option to use each file's background as it was 
originally created. 

Solid 

Choose this option to give your picture a solid background 
color. You must also specify the RGB values for the solid 
color. MAGICorp offers color palettes in each of the 
media it supports so that you can examine the appear­
ance of various combination ofRGB values. 
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Gradated 

Choose this option to give all the pictures one of two gra­
dated backgrounds. Click in the text field and then type 
the number for one of these styles: 

Style #l-Top-bottom grodoted 

Choose this style to blend two colors from the top to the 
bottom of the picture. This is the default style. 

Specify the RGB values for Color One, the color at the top 
of the picture. 

Specify the RGB values for Color Two, the color at the bot­
tom of the picture. 

Style #2-Center-grodoted 

Choose this style to give all pictures a smooth, gradated 
background, blending two colors from a center horizontal 
line to the top and bottom of the picture. 

Specify the RGB values for Color One, the color at the top 
and bottom of the picture. 

Specify the RGB values for Color Two, the color at the 
middle of the picture. 

Solid or Color One and Color Two RGB Values 

You change the background color by entering RGB (red, 
green, and ~lue) values for the new color. RGB values rep­
resent the amounts of red, green, and blue in a color. 
Type a number from 0 to 999 for Color One and/or Color 
Two, depending on whether you choose a gradated back­
ground. 

Showstopper Background 

Choose this option to give all the pictures a showstopper 
photographic background. You select the background and 
its code from the Showstopper catalog, which is available 
from MAGICorp. There is an extra charge for using show­
stopper backgrounds. 
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To specify a Showstopper background: 

[IJ Click on the Number field and type the four-charac­
ter Showstopper code. 

[]] Click on the Tint box to indicate that you have chosen 
a tintable background (those backgrounds whose 
codes begin with "C"). The tint will be the color you 
specified for your Original, Solid, or Gradated color 
background. There is no effect on the background if 
you select the Tint box after you select a non-tintable 
background. 

To exit the Global Background dialog: 

Click on OK to accept the settings and exit the dialog, or 
click on Cancel to discard the changes. 

Work Order Dialog 

MAGICorp 

To display the Work Order dialog, choose the Work 
Order command from the Preferences menu. 

Presentation nane: 
(onnents 
1: ____________________________ _ 
2: ____________________________ _ 
3: 

You must fill in the information options and fields in this 
dialog before you transmit your files to MAGICorp. The 
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information you supply is stored in a job summary file 
that is transmitted when you send your files. 

Turnaround 

Use this option to indicate a turnaround time. There are 
four priorities: 

Super Rush 

Orders for fewer than 25 slides received by MAGICorp be­
fore 10:00 p.m. EST. will be shipped the same day for de­
livery the next business morning. You must call the 
Network Controller at 1-800-367-6244 by 7:00 p.m. EST 
to get an approval number for the order. Super Rush ser­
vice may not always be available. 

Rush 

Orders for fewer than 50 slides, received between noon 
and 6:00 p.m. (your time zone), will be shipped the same 
day for delivery on the next business day. Rush service 
may be available after 5:00 p.m. For more than 50 slides 
or other media, consult the MAGICorp Network Control­
ler at 1-800-367-6244 to confirm availability before trans­
mitting your order. 

Normal 

Orders received before noon (your time zone) will be 
shipped the same day for delivery on the next business 
day. 

Economy 

Orders received before noon (your time zone) will be 
shipped the next day for delivery the following business 
day. 

Orders received by MAGICorp on weekends and holidays 
will be treated as if they were received before noon on the 
next business day. If you order photographic prints or 
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transparencies, you will receive your order one day later 
than is the case for slides. 

Presentation name 

You can assign a name for the Artline files you are trans­
mitting. The name can be up to 15 characters. This 
name does not have to match an Artline filename. 

Comments 

You can type up to three lines of notes in this field. Use 
the up or down cursor arrow keys to move from line to 
line. Use the comments lines to provide extra informa­
tion about your order, such as your home phone number. 
MAGICorp cannot guarantee that instructions in the 
Comments field will be executed if you do not confirm 
them by calling the Network Controller. 

Job Summary 

Click on the "Save job summary file" option to save a file 
that lists all your choices in the Work Order dialog. 

Job Summary Filename 

Assign a filename for the job summary file (the default is 
MAGICORP.JOB). MAGICorp prints a summary sheet 
that lists your choices in the Work Order dialog. Keep 
this sheet in case you want to contact MAGICorp about 
your order. 
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Transmission Dialog 

@ b!J 
Moden 

To display the Transmission dialog choose the Transmis­
sion command from the Preferences menu. 

@ Auto 
o Manual 

@ Tone 
o Pulse 

o 1288 Baud 
@ 2488 Baud 

@ (OM1 
o (OM2 

Nunber to dial: 1-B88-227-624~f-____ _ 

o b!J Disk 
Drive: []] 

You must fill out this dialog before you can transmit files 
to MAGICorp. You can either transmit your files by 
modem over the telephone lines (toll-free) or send the files 
on a disk. If you send by disk, the disk is not returned. 

By Modem 

Choose this option to send by modem. You must then set 
the modem options: 

Auto or Manual 

These options specify whether you dial the telephone auto­
matically or manually. If you choose Auto, the phone 
number you specify in the Number to dial field is dialed 
automatically by the modem and the MAGICorp software. 
If you choose Manual, you must dial the phone number. 

Tone or Pulse 

Choose one of these options to specify whether you have a 
touchtone or pulse telephone. 
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1200 Baud or 2400 Baud 

Choose one of these options to specify the modem trans­
mission baud rate. 

Com 1 or Com 2 

Choose one of these options to specify the computer port 
to which your modem is connected. 

Number to dial 

Type MAGICorp's modem phone number; this is the 
phone number your modem will dial. Parentheses or 
dashes are optional. If necessary, type any prefix neces­
sary to obtain an outside line from your office. Then type: 

1-800-227-6244 (inside the continental United States) 

1-914-592-1053 (outside the continental United States) 

By Disk 

Choose this option to send your files to a disk. You can 
send this disk directly to MAGICorp or take it to another 
computer that has a modem and on which Artline is in­
stalled. 

Drive 

To specify the disk drive, click on the Drive box. If you do 
not want to send the files to a disk in Drive A (the de­
fault), press Shift-Delete or the Backspace key to clear 
the field, then type the letter of the drive to which you 
want to send your files. 

Send your disks to this address: 

MAGICorp 
50 Executive Blvd. 
Elmsford, N.Y. 10523 
ATTN: Network Controller 

(Disks cannot be returned) 
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To exit the Transmission dialog: 

Click on OK to accept the settings and exit the dialog, or 
click on Cancel to discard the changes. 

Showstopper Shadows Dialog 

To display the Showstopper Shadows dialog, choose the 
Showstopper Shadows command from the Preferences 
menu. 

Direction Distance Darkness Sharpness 
o 1: Top right Min 1: @ * 0 0 
@ 2: BOttOM right* 2: 0 0 0 
o 3: BOttOM left 3: 0 0 0 
o 4: Top left 4: 0 0 0 

MaM 5: 0 @* @* 
*Default values 

You use the dialog to enable drop shadows for your pic­
tures. Default values are marked with an asterisk. 
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To enable Showstopper shadows: 

[JJ Click on the Enable shadows button. 

[]] Click on one of the Direction buttons to indicate the 
direction in which to cast the shadow. 

[[] Click on a Distance button to indicate the desired dis­
tance between your picture and its shadow. 

This option specifies the distance the shadow is cast. 
The greater the distance setting, the greater the 
space appears between your design elements and the 
background. 

[±] Click on a Darkness button to indicate the desired 
darkness value. 

This option specifies the transparency of the shadow. 
Shadows can be opaque or sheer (allowing back­
ground patterns to show through). The minimum set­
ting causes the shadow to be nearly transparent; the 
maximum setting causes it to be opaque. 

[]] Click on a Sharpness button to indicate the desired 
sharpness value. 

This option specifies the distinctness of the shadow. 
Minimum sharpness causes the shadows to be fuzzy 
and diffused; the maximum setting creates sharp, 
crisp shadows. 

To exit the Showstopper Shadows dialog: 

Click on OK to accept the settings and exit the dialog, or 
click on Cancel to discard the changes. 
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Artline Charac-ter Set 

The table on the following pages lists the characters avail­
able in the Artline International Character Set. To enter 
characters that are not available directly from the key­
board into the Create Text Element dialog, hold down the 
Alt key as you enter the ASCII decimal value on the 
keyboard's numeric keypad. For example, the paragraph 
symbol (Il) is Alt-188. 

NOTE: You cannot display Symbol and Wombat characters in the 
Create Text Element dialog; instead, you will see the corre­
sponding international character. Mter you exit the dialog, 
the correct character appears on the drawing surface. 
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Cii co Cii Cii 
t: t: t: t: 
.2 en 0 en .2 en .2 en 

Cii - - m :.;:: - Cii - (5 - Cii - (5 -co (5 co co (5 co co co co co 
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~49 0 111 0 ± ® 205 1 c e 233 c) 

~50 ti 118 ¥ " ® 206 t E 0 234 ¢ 

~5~ U ~19 ¢ ~ @ 201 I ~ 0) 235 L ~ 
~52 Y ~80 re x ® 208 0 L 0 236 ~ 
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154 iT 182 A d 0 2~O 0 ® CD 238 ~ 

155 Ii!J 183 A • 8 211 S © C[f) 239 Q 

H56 £ ~84 () + 8) 2~2 S TM ~ 240 \ 

151 0 185 § -:1= 0 2~3 U II -+ 24~ I c::> 
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~59 f 181 t ::::: <D 215 (] t 243 ... 
~60 a ~88 ~ ... f) 2~6 Y --, "- 2M ... 
161 i 1 fJ" 189 © I «I 2~1 6 1\ * 245 ~ 

.... 
162 6 

, t 100 ® - G) 2~8 6 v ;t 246 .ttl' 

~63 U s T 191 TM .J CII) 219 <=> ~ 241 ~ 

~6A ii / • ~92 " 
N <D 220 <= .. 248 ... 

~65 N 00 • ~93 ... S ® 221 11' ~ 249 ~ 

166 ! f ~ 194 %0 9t ® 222 => -+ 250 ... 
~6'l Q -It ~ 195 • fcJ @ 223 ~ ,,.. 251 ... ... 
~68 l • tit ~96 - ~ @ 224 0 "" 252 .. 
169 " • • ~91 - E9 ® 225 ( • 253 .. 
110 " • • 198 

0 

0 (J) 226 ® :> 254 =*> 

r1~ < H ~ 199 A (I @ 221 © > 255 
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CNF Files 

F or certain printers, the GEM 4.0 printer driver reads a configura­
tion file (.CNF) that contains information the driver uses to con­

figure a specific printer. You can alter a . CNF file to change the 
operation of your printer. For example, if you need to change the 
margins of the printable area for your PostScript printer, or if you 
want to add new PostScript fonts, you can change your .CNF file to 
achieve this result. 

CNF Files 

A unique .CNF file is provided for each of these printer 
types: 

o the Hewlett-Packard® soft font printers; 
o the Hewlett-Packard Painjet XL; 
o all PostScript printers. 

The .CNF files are ASCII files that have the filename 
form ddd.CNF. The letters ddd are a driver identification 
that is taken from the driver's filename, which uses the 
form PDddd9.fff. The letters fff are a font extension such 
as ELQ or B30. Entries in a .CNF file have this format: 

KEYWORD (PARM1,PARM2,PARM3, ... ) 

KEYWORD describes the function to be adjusted or in­
cluded, and PARMI PARM2 PARM3 ... are parameters 
that modify or describe KEYWORD. Parameters can be 
separated by commas. 
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Modifying CNF files 

Modifying CNF files 

B-2 

To modify a .CNF file: 

[I] Use a word processing program, or a line editor that 
can save pure ASCII files, to open the .CNF file you 
want to change. For example, if you are using a 
monochrome PostScript printer, you would open 
PSMONO.CNF. 

[ill Type the parameters for each function you want to 
alter or add. The functions and parameters are de­
scribed in the following pages. Do not place any extra 
spaces within the .CNF file. 

[[] Save the .CNF file as an ASCII file with its existing 
filename. 
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Hewleff-Packard Soft Font Drivers 

Hewlett-Packard Soft Font Drivers 

The .CNF file for a Hewlett-Packard soft font driver has 
this format: 

OOWNPATH (OIR) 

PERMFONT (10 FILENAME) 

FONTSPEC (FILENAME 10 SIZE ATTR MAP) 

DOWN PATH 

DOWNPATH identifies the directory that contains .HFI 
files and soft font files. The parameter is: 

OIR the path name of the directory. If you give a rel­
ative path, it is taken as relative to the directory 
containing the driver. The default is ".", the di­
rectory containing the driver. 

PERMFONT 

PERMFONT indicates that the soft font has already been 
downloaded to the printer. Digital Research does not 
provide a separate downloading program. When the 
PERMFONT function is enabled, the driver examines the 
soft font file for character width information but does not 
send the font to the printer. The parameters are: 

10 the unique soft font identifier number, 
which you obtain from the downloading 
program. 

FILENAME the soft font filename. 

These parameters have no default values. 

FONTSPEC 

CNF Files 

FONTSPEC provides an alternative to .HFI files. It gives 
the driver information about a soft font that is available 
for downloading. The parameters are: 

FILENAME 
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Hewlett-Packard Soft Font Drivers 

8-4 

10 

SIZE 

ATTR = 0 

ATTR = 1 

ATTR = 4 

ATTR = 5 

MAP=O 

MAP= 1 

the soft font filename (which requires 
no extension-the driver will use the ex­
tensions .SFP and .SFL). 

the GEM font identifier. 

the font size in points. 

the font attribute for Normal. 

the font attribute for Bold. 

the font attribute for Italic. 

the font attribute for Bold Italic. 

remaps the character set to the HP char­
acter set. 

remaps the character set to the 
GEMNentura character set. 
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PostScript Drivers 

PostScript Drivers 

The .CNF file for a PostScript driver has this format: 

MARGINS (XL XR VT VB) 

PFI (ON_OFF) 

PSFONTS (DIR) 

FONT (NAME ID ATTR MAP RESFLAG) 

MARGINS 

PFI 

CNF Files 

MARGINS sets margins that limit the graphics output to 
the printable area. In the provided PSCOLOR.CNF file, 
the left and right margins are 0.25", with 1" for the top 
and bottom margins. For the PSMONO.CNF file, the left, 
right, top, and bottom margins are 0.25". Check the man­
ual for your your printer to determine whether it has 
these margins. If the margins are different, you should 
edit the .CNF file to set the desired margins. 

The parameters are: 

XL sets the left margin in device units. 

XR sets the right margin in device units. 

The default value for XL and XR (for 0.25") is 75 in device 
units. 

VT sets the top margin in device units. 

VB sets the bottom margin in device units. 

PFI indicates whether a PostScript Font Information 
(.PFI) file search is requested. The .PFI files should be lo­
cated in the directory that contains the downloadable 
PostScript ASCII or binary format fonts. 
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PostScript Drivers 
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The parameters are: 

ON_OFF = 0 disables the driver search for .PFI files 
(the default). 

enables the search. 

PSFONTS 

FONT 

PSFONTS identifies the directory that contains the .PFI 
file and associated PostScript downloadable font files. 
The parameter is: 

OIR the path name of the directory. If you give a rel­
ative path, it is taken as relative to the directory 
containing the driver. The default is ".", the di­
rectory containing the driver. 

FONT provides an alternative to supplying a .PFI file for 
the PostScript font. 

Using FONT to Add PostScript Fonts 

The PostScript .CNF file has information for the standard 
35 resident PostScript fonts. If you add PostScript fonts, 
you must alter your PostScript .CNF file. For each new 
PostScript font you add to Artline, you must provide a 
new FONT line in the .CNF file. 

For FONT, each line in the . CNF file has this format: 

font{NAME, 10, AnR, MAP, RESFLAG) 

For example, if you installed the Adobe Type 1 font Gal­
liard-Bold, you would add the following line to the .CNF 
file: 

font{Galliard-Bold,32,B,TEXT,OOWN:GLB.PFB) 
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CNF Files 

The parameters are: 

NAME 

10 

ATTR= M 

ATTR = 8 

ATTR = I 

ATTR = 81 

MAP=TEXT 

MAP= PI 

RESFLAG = RES 

PostScript Drivers 

the font's PostScript name. 

the font identification number 
(see Appendix C for a list of font 
ID numbers). 

the font attribute for Normal. 

the font attribute for Bold. 

the font attribute for Italic. 

the font attribute for Bold Italic. 

enables the re-encoding of the 
character set. 

disables the re-encoding of the 
character set (for symbol fonts). 

shows that the font is resident. 

RESFLAG = DOWN :filename 

indicates that the font filename 
must be downloaded. 
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Fon-t ID Numbers 

YlrUIIS table lists the font identifications ( IDs) for many common 
JL typefaces. The typeface names are listed alphabetically. 

Typeface Font 10 Typeface Font 10 

American Classic 47 Brush 41 

American Classic Extra Bold 48 Century Old Style 38 

American Typewriter 100 Century II 43 

Antique Olive 61 Century II Light 49 

Antique Olive Compact 70 Cheltenham 39 

Avant Garde (BooklDemi) 51 Courier 102 

Avant Garde (Medium/Bold) 81 Commercial Script 3 

Baskerville 33 Cooper Black 8 

Bauhaus 66 Dom Casual/Dom Diagonal 75 

Benguiat (Book/Bold) 26 Dutch (serifed) 14 

Bitstream Charter 9 Fixed Pitch (monospaced) 1 

Blackletter (Cloister Black) 10 Franklin Gothic 56 

Bodoni (Medium/Bold) 36 Franklin Gothic Heavy 57 

Bodoni Poster 37 Friz Quadrata 28 

Bookman (LightlDemi) 23 Futura (Medium/Bold) 62 

Broadway 80 Futura Book 83 

Font ID Numbers C-l 



Font 10 Numbers 

Typeface Font 10 Typeface Font 10 

Futura Extra Black 85 Lucida Serifed 45 

Futura Heavy 84 Machine 101 

Futura Light 82 Manhattan 77 

Futura Medium Condensed 86 Melior 31 

Galliard 32 New Century Schoolbook 20 

Garamond (LightIBold) 22 Old English 4 

Gill Sans 63 Optima 52 

Gill Sans Extra Bold 64 Optima Outline 78 

Globe Gothic Outline 76 Orator 104 

Glypha 27 Palatino 21 

Goudy 34 Park Avenue/Coronet 35 

Helvetica/Triumvirate 67 Prestige Elite 103 

Helvetica Black 55 Raphael 5 

Helvetica Condensed 59 Sonata (Music) 130 

Helvetica Condensed Black 60 Souvenir (LightlDemi) 25 

Helvetica Condensed Light 58 StuntlRevival Roman 7 

Helvetica Light 54 Swiss (san seriD 2 

Helvetica Narrow 50 Symbol (Math/Greek) 128 

IBM Keycap 131 Times Roman 15 

Korinna 53 Trump 30 

Letter Gothic 105 CG Trade Condensed 72 

Lubalin Graph (BooklDemi) 24 CG Trade Extra Condensed 73 

Lubalin Graph Extra Bold 42 CG Trade Extended 74 

Lucida Monospaced 106 Uncial 6 

Lucida San Serif 69 Uncle Sam Open 79 
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Font 10 Numbers 

Typeface Font 10 Typeface Font 10 

Univers 65 

Univers Extra Bold 71 

Zapf Chancery 29 

ZapfDingbats 129 

NOTE: At the time of printing, these typefaces were assigned font 
IDs. If you receive an updated list from Xerox Ventura 
Publisher, you might want to add those identification num­
bers to this table. 
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"Abandon/Save" alert (Output), 2-9 
Adobe Font Metric files, 1-5 - 1-6 
Adobe Type 1 fonts 

converting, 1-5 
.AFM files, 1-2 - 1-3 
Alt key, A-I 
Artline International Character Set, C-l 
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B 
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converting, 1-5 
Bitstream Fontware fonts 

converting, 1-4 
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c 
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Artline International, C-l 
character weight, 1-6, 1-8 
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.CNF files, B-1 
Color command (Output), 2-21 
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Global Background, 3-9 
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Showstopper Shadows, 3-16 
Transmission, 3-14 
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Film, 2-20 
Global, 2-10 
Network Settings, 2-12 
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Quit, 2-9 
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Screen, 2-14 
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creating Output lists, 2-6 
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DEVICES window (Output), 2-3 - 2-4 
directory line (Ouput), 2-4 
displaying files (Output), 2-7 

keyboard shortcuts for, 2-15 

E 
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exiting Output, 2-4 
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.FDF files, 1-1 
File Label command (Output), 2-12 
File menu (Output), 2-8 
Files 

.AFM, 1-2 - 1-3 
ASCII, B-2 
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.IMG, 2-4 
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.LIS, 2-6, 2-10 

.PFA, 1-4 

.PFB, 1-5 

.PFI, 1-4, B-6 
PSMONO.CNF, B-2, B-9 

File Selector (Output), 2-2, 2-4 - 2-5, 2-7 
changing directories in, 2-4 
close box in, 2-4 
file box in, 2-5 

file types (Output), 2-5 
FILES TO PRINT list (Output), 2-2,2-4,2-7, 

3-7 
changing filename order in, 2-5 
duplicating filenames in, 2-5 

Film command (Output), 2-20 
font filters, 1-1 
font IDs, C-l 

duplicates, 1-7 
Fontographer fonts 

converting, 1-7 

G 
Global Background command (MAGICorp) 
3-9 ' 
Global command (Output), 2-10 

H 
Hayes modem, 3-1 
Hewlett-Packard Soft Font Driver functions 

(.CNF files), B-3 - B-4 ' 
DOWNPATH, B-3 
FONTSPEC, B-4 
PERMFONT, B-3 

.INF file, 2-13 
Item Selector (Output), 2-7 
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K 
kerning information files (.AFM), 1-4 - 1-5 
keyboard shortcuts (Output) 

for displaying files, 2-15 

L 
.LIS files (Output), 2-6,2-10 

M 
MAGICorp 

camera service, 3-1 
color laser prints, 3-8 
color transparencies, 3-8 
getting Help in, 3-4 
icon in Output DEVICES Window, 3-3 
photographic types, 3-7 
preparing pictures for, 3-2 
RGB values with, 3-10 
sending files to, 3-2 
Showstopper catalog, 3-10 
site code, 3-1, 3-5 
slide service driver, 3-1 
slide types, 3-7 
telephone numbers for, 3-2 
use of modems with, 3-15 

Media Selection command (MAGICorp), 3-6 
menu bar (Output), 2-2 
menus, choosing, 2-7 
modems, use of with MAGICorp, 3-1, 3-14 
modifying .CNF files, B-2 

N 
Network Settings command (Output), 2-12 
New command (Output), 2-8 

o 
Open command (Output), 2-8 - 2-9 
Options menu (Output), 2-10 
Output Info command, 2-24 
Output lists 



creation of, 2-6 
opening of, 2-7 

Output screen components, 2-2 

p 
Page Scale command(Output), 2-11 
Paper Size command (Output), 2-16 
Paper Tray command (Output), 2-17 
.PFAfiles 

converting, 1-4 
.PFB files 

converting, 1-5 
.PFI files, 1-4, B-9 
Port Selection command (Output), 2-18 
PostScript font conversion, 1-4 - 1-8 
PostScript Driver functions (.CNF files), 

B-5 - B-6 
EOFTYPE, B-6 
FONT, B-7 
IMGTYPE, B-6 
MARGINS, B-5 
PFI, B-5 
PSFONTS, B-6 

Preferences menu (Output) 
cameras, 2-20 
MAGICorp, 3-3 
printers and plotters, 2-16 
screens, 2-14 

printing in Output, 2-3 
PSMONO.CNF, B-2, B-9 

Q 
Quit command (Output), 2-9 

R 
Remove Name button (Output), 2-2, 2-3 
RGB settings (Output), 2-22 
running font filters, 1-1 

s 
Save As command (Output), 2-7, 2-8 
Save command (Output), 2-7, 2-8 
Save Preferences command (Output), 2-13 
Screen command (Output), 2-14 
Showstopper Shadows command 

(MAGICorp),3-16 
START button (Output), 2-2, 2-3, 2-7 
starting Output, 2-1 

T 
title bar (Output), 2-2 
To App command, 1-1 - 1-3 
To Artline command (Output), 2-3, 2-9 
To Output command, 2-1, 2-3, 3-2 
Transmission command (MAGICorp), 3-14 

w 
weight 

text characters in font file conversion, 1-6, 1-8 
Work Order command (MAGICorp), 3-11 
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